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Preface

ILWISisan acronym for the Integrated Land and Water Information System.
It is a Geographic Information System (GIS) with image processing capabilities.
ILWIS has been developed by the International Institute for Aerospace Survey and
Earth Sciences (ITC), Enschede, The Netherlands. For more than a decade, since
1985, the software has undergone major improvements. The last of which includes
the change from DOS to the MS-Windows environment. The release of ILWIS for
Windows marks a new erain the development of the software.

AsaGIS package, ILWIS alows you to input, manage, analyze and present geo-
graphical data. From the data you can generate information on the spatial and
temporal patterns and processes on the earth surface.

The ILWIS media

The ILWIS Beginner’'s Guide is part of the documentation for ILWIS 2.1. The full
documentation includes:

- ILWIS Installation Guide. Instructions for setting up ILWIS and
guidelines for setting up hardware, such as digitizers and printers;

- ILWIS Beginner’s Guide. A first look at ILWIS, introducing the basic
concepts, some essential ILWIS techniques and the main operations
included with ILWIS;

- ILWIS User’s Guide. Training in the skills you need to work with
ILWIS. It provides numerous exercises to practice GIS techniques and
Image Processing operations,

- ILWIS Applications Guide. Advanced procedures to work with
ILWIS, providing 25 case studies for various research disciplines;

- ILWIS Reference Guide. Detailed description of the functionality of
ILWIS including its window types, the objects, the operations, etc.,
illustrated with tips and examples.

Besides these Guides, extensive on-line and context-sensitive Help is available in
the program.

The ILWIS Beginner’s Guide: Main objectives

The ILWIS Beginner’s Guide is especialy designed for new ILWIS users. It
contains simple GIS and Image Processing exercises introducing you to the
software.

It isintended for those who want to get afirst impression of ILWIS 2.1. Those
persons who want to learn how to work with ILWIS 2.1, and how ILWISisusedin
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basic GIS and Image Processing operations are referred to the ILWIS User’'s

Guide.

Structure of the ILWIS Beginner’s Guide
The ILWIS Beginner’s Guide consists of 5 chapters.

The data set

Chapter one, ILWIS Main window, explains the way to start up ILWIS
and the functions of the Main window;

Chapter two, Visualization, shows how to display maps, tables and
graphs;

Chapter three, Retrieval of information, explains how you can retrieve
information using the mouse or through the pixel information window;

Chapter four, Operations, gives some examples of operations applied
on maps and tables;

Chapter five, Annotation, shows how to create some annotations (title,
text, north arrow etc.).

All datafilesrequired for the exercisesin the ILWIS Beginner’'s Guide are
included on the CD-ROM, which aso contains the software, and the data for the
User’'s Guide and the Applications Guide. The files can be found in the directory
d:\bgnguide (where d isthe drive letter of the CD-ROM drive).

During the installation of ILWIS you can install the data files on your harddisk,
normally in the directory c:\ilwis21\data.

!f If you did not install the data files during the installation of ILWIS, you should
till do so, before continuing. See the ILWIS Installation Guide on how to
install data files. Y ou can aso use the Windows File Manager to copy the
data files from the CD-ROM to your harddisk.

The subdirectory of c:\ilwis21\data will be the working directory for the exercises
of the ILWIS Beginner’'s Guide.

M

+  When you want to repeat the exercises of the Beginner’'s Guide, we

recommend that you copy the original data files from the CD-ROM, or use the
ILWIS Installation program, so that you always start with the origina files,
and not with files which may be altered.

ILWIS Beginner’s Guide
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Conventions used in the ILWIS Beginner’s Guide

This manual is formatted in such away that the specific actions dealing with the
software are separated from the accompanying text.

&
Thisisan exercise box. You can follow the instructions step by step.
Wordsin Times New Roman 10 Italics are keywords.

Formulas that you should type are shown in Cour i er New 10.
For example: Mapc = Mapa + Mapb

All information that should be supplied by the user is also shownin
Courier New 10, aswell asall the names of objects (maps, tables,
columns, etc.)

For example: Geol ogy.

The names of operations, dialog boxes and the options in dialog boxes
are shown in Arial 10.
For example: Display Options - Raster Map.

!f Thisisatip-box. It isused to give tips.

The ILWIS Beginner's Guide was made on computers with SVGA display (with a
resolution of 1024 by 768 pixels, and 256 colors). If you are working on a screen
with alower resolution, some of the picturesin the book may look dightly different
from the ones displayed on the screen. Thisis even more so when you work in
VGA mode (640 by 480 pixels, and 16 colors); the display of some of the maps and
images may be confusing. We therefore recommend you to have at least a
resolution that allows you to display 256 colors.

The ILWIS Beginner’s Guide was prepared with ILWIS running under Microsoft
Windows 3.1, with the Windows default color scheme, so all ILWIS windows
shown in this book are in the Windows 3.1 fashion.

ILWIS Beginner’s Guide iii






Chapter 1

ILWIS Main window

When you start ILWIS, the first thing you will see after the opening screen, isthe
Main window (see Figure 1.1).

Button bar Command line Title bar Minimize button

Control-menu box Menu bar Change drive Change directory
4| ILWIS 2.1 ehilwis2I\data) v

File Edit Operations vOptions| Help

v

@] o Elcv|t|cdata v [z
EhAggregate  [+|catchmen Ellgeom Ehtmb3
EhApply3D | citybl [l geom Ehtmb4

E AreaNumb [ citybl Eilanduse Eftmb5h

=y AttribPnt FEicontour M landuse Eftmbb

) AttribPol Eidrainage LS rainfall Ehtmb7

R AttribRas FEifaults M rainfall Eview3dl
) AttribSeq x R geology Ehtmb1 2 Bview3d2
[ AutoCorr @j geology Ehtmb2 0.

Classify 4

E Classify [ N 3|

\Press F1for Help \

Status line Operation-list Scroll bar Catalog
Figure 1.1 The ILWIS Main window (in Windows 3.1).
From this window you can start all operations and select all data. On the left, there

isalist of GIS and image processing operations and other tools, called the
Operation-list.
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ILWIS Main window
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Use the vertical scroll bar next to the Operation-list to see more
operations.

Place the mouse pointer at one of the Operationsin the Operation-

list, for example Show.

Y ou will see a short description of the operation on the status line at the bottom of
the Main window.

&

Press the right mouse button on any operation and select Help to get
a short explanation of the operation.

To be able to continue with this chapter you need to have direct access to the ILWIS
Demo Data set. This means that your current drive and working directory
(CNILWIS21\DATA) have to be the ones that contain the ILWIS Demo Data set. In
case you are not in the right working directory you will need to change this.

To change the current drive and working directory, you can use the navigator:
to change drive,
to change directory.

&

To change the working drive, click the Change Drive icon and
select the drive which contains the ILWIS Demo Data set.

To change the working directory, click the Change Directory icon
and select the directory which contains the ILWIS Demo Data set.

Now you should be able to directly access the Demo Data.

On the right part of the Main window, maps, tables and other objectsin the
working directory are displayed, each with its own icon. This part of the Main
window is called the Catalog.

In the Catalog the following icons are used for data objects:
for raster maps (for examplet nb1),

for polygon maps (for example | anduse),

for segment maps (for example cont our ),

for point maps (for exampler ai nf al 1),

for tables (for exampler ai nf al | ).

ILWIS Beginner’s Guide



ILWIS Main window

Place your mouse pointer at a map or table in the Catalog, for
example on polygon map | anduse. A description will appear on the
statusline.

Press the right mouse button on a map to get a context-sensitive
menu.

The context-sensitive menu shows operations which can be applied on the selected
object.

At the top of the Main window, you see the menu bar, the command line, and a
button bar. The menu bar, can among others, be used to select al operations, to
change the contents of the Catalog and to access the Help menu. The command line
can be used to type commands or calculations. The button bar provides short cuts
for certain menu commands.

The button bar contains the following buttons:

Hide/Show Operation-list button: to hide or show the Operation-list in the Main
window,

_ _
Show Map button: to open araster, segment, polygon or a point map or any other
object in a new window,
Show Table button: to open atable in a new table window,

L Show Pixel Information button: to open the Pixel Information window,

i Customize Catalog button: to select the object types to be shown in the Catalog.

In ILWIS an action can be performed in different ways.

To start an operation, you can:

- double-click an operation in the Operation-list, or

- usethe Operations menu in the Main window, or

- select the datain the Catalog you want to perform an operation on, and press
the right mouse button to get a context-sensitive menu, or

- use the command line and type a command.

For example, there are several methods to open a map:

- double-click amap in the Catalog, or

- press the right mouse button on a map in the Catalog and select Open from the
context-sensitive menu, or

- click the Show Map Button in the button bar, or

- double-click Show in the Operation-list, and select a map, or

- choose Visualization, Show Map from the Operations menu, or

- typeQpen Mapname.ext on the command line.

ILWIS Beginner’s Guide 3






Chapter 2

Visualization

A map is displayed in amap window and atable is displayed in atable window. To
move a window, place the mouse pointer at atitle bar, press and hold down the left
mouse button while you move the mouse. A window can be resized by dragging a
window border.

2.1 Display maps

The way maps are displayed in ILWIS for Windows is controlled by the user.
Before amap is displayed, a dialog box will be presented. In this dialog box you are
prompted to answer some questions about the display of the map in the map
window.

The easiest way to open amap is to double-click it in the Catalog (press the left
mouse button twice in rapid succession).

&

Double-click raster map t nb1 in the Catalog.

The Display Options - Raster Map dialog box is presented.

&

Accept the defaults by clicking the OK button or pressing <Enter>.

A map window is opened displaying t mb1(Figure 2.1 shows part of thisimage).
Thisraster map is band 1 of a Thematic Mapper satellite image. The brightness of
the pixels corresponds with the reflectance of light on the earth surface. On the
status line at the bottom of the map window you can see the column and row
numbers and the XY -coordinates of the place of your mouse pointer when it is
located in the map window.

&

Press the left mouse button in the map window.

Y ou will see the reflectance value of the pixel at the location of the mouse pointer.

ILWIS Beginner’s Guide 5



Visualization

Button bar Menu bar Maximize button
Control-menu box Title bar Minimize butto
X tmi1: LandSat TM Hand 1 M
File Edit Layers Options YHelp
R & 2 % | D] %
+
A A n
+ A *
| |Press Flgfor Help /
Status line Map viewer Scroll bar

Figure 2.1 Example of an ILWIS map window.

Y ou can zoom, resize the window and interactively measure distances and angles
using the buttons in the button bar of the map window (see Figure 2.1). The status
line gives brief information on the effect of a button when you move the mouse
pointer over the buttons in the button bar. By using the scroll bars, you can scroll
through the image.

&

Click the Zoom In button. Then drag an area with the left mouse
button to define the zooming area.
Zoom in acouple of times to see the pixels in the map as little blocks.

Click the Measure Distance button, press and hold down the | eft
mouse button while you move the mouse. The distance between the
two points is displayed. When you release the left mouse button both
the distance and angle between the two points are displayed.

Click the Entire Map button to get the map back to its original size.

ILWIS Beginner’s Guide
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Theimaget nbl can also be displayed in other colors.

&

Press the right mouse button in the map window and select the layer
1map tnbl.

The Display Options - Raster Map dialog box is presented again.

&

Select representation pseudo instead of the default gray in the
Display Options dialog box and click OK.

The map is displayed using blue colors for low values, green for intermediate
values and red for high values. Try also some other representations, for example
i nver se or col or st p10. Finally change the representation to gr ay again.

To compare raster map t mb1 with other images you can open raster map t nb2.

&
Double-click raster map t nb2 in the Catalog. Accept the default
display options.
Drag the map window by the title bar to another place on the screen
to be able to see both maps.

Place the mouse pointer in either of the map windows and press the
left mouse button to get the reflectance values. Y ou can easily switch
between the map windows.

Closet mb2 by choosing Exit from the File menu.

Instead of opening a new map window to display another raster map, you may also
use drag and drop to change the contents of a map window.

If adrag and drop is allowed, you see the icon of the map that you drag, e.g. B,
If adrag and drop is not allowed, you see the® icon.

&

Select raster map t nh4 in the Catalog, drag it to the existing map
window of t nb1 and drop it on raster map t nb1.

ILWIS Beginner’s Guide 7
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All other types of maps can also be opened in a map window.

&

Place the mouse pointer on polygon map | anduse, press the right
mouse button to get the context-sensitive menul.

Select Open.
Accept the default display options and click OK.

Press the left mouse button in the map window to get information.

For each unit in the map you will see the name of land use class. The information
you get depends on the domain of a map. In this case the domain consists of the
names of the land use classes. The domain type of thismap is class.

A domain isanew concept in ILWIS for Windows, it is a user-defined collection of
possible class names, ID’ s or values that may occur in amap or in acolumn of a
table (also see User’'s Guide and the on-line Help). For a satellite image like

t nb4, values arein the range of 0 to 255, which are called the reflectance values.

&

Close the polygon map | anduse by double-clicking the Control-
menu box. The Control-menu box is located in the upper left corner
of amap window.

2.2 Display a 3D view of the Cochabamba area

For an impression of the Cochabamba area, open the 3D views prepared from
images and a height model.

&

Double-click raster mapsvi ew3D1 and vi ew3D2, accept default
display options, zoom in, zoom out and scroll through the area.

2.3 Display multiple layers

Until now, you have displayed raster maps and a polygon map in separate windows.
In the next exercise, you will display different mapsin one map window by adding
segment, polygon and point maps as layers.

8 ILWIS Beginner’s Guide
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Drag segment map cont our which contains contour lines of the
area and drop it in the existing map window of t nmb4.

In the Display Options - Segment Map dialog box, select Single
Color and select abright color, like yellow, to obtain a good contrast
with the dark colors of the satellite image.

Click OK.

The segments are drawn as a layer on top of the raster map t nb4.

&

Press the right mouse button in the map window.

On the context-sensitive menu, below the horizontal line, you will see the two
layers in the map window, the raster map t nb4 and the segment map with contour
lines. Let’s also add polygon map | anduse.

&

Open the Layers menu in the map window, choose Add Data Layer,
Polygon Map and select the polygon map | anduse.

Click OK in the Add Polygon Map diaog box.

In the Display Options dialog box select Boundaries Only. Select a
color for the boundaries and click OK.

The boundaries of the polygon map | anduse are drawn as another layer in the
same map window.

&

Press the left mouse button in the map window and you will get
information on the land use classes.

Instead of the land use classes you might want to see the reflectance values of the
raster map t nb4. Y ou can change the behavior and the order of layersin amap
window in the Layer Management dialog box.

ILWIS Beginner’s Guide 9
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&
Press the right mouse button in the map window and select Layer
Management. The Layer Management dialog box is opened (Fig
2.2)

=| Layer Management
B landuze show info* -
2 contour show
B tmb4 show info

| Add Annotation I

Drag objects to change order

Figure 2.2 The Layer Management dialog box.

In this dialog box, all layersin the map window are listed. Y ou can select layers by
clicking them. A selected layer appears highlighted.

For the selected layer, you can select or clear the Info check box to indicate whether
you want information of the specified layer when you click the left mouse button in
the map.

&

Select polygon map | anduse in the Layer Management dialog
box and clear the Info check box. No crossis visible in the check box
now.

Click OK.

Press the left mouse button in the map window and move through the
map, you will get the reflectance values.

10 ILWIS Beginner’s Guide
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The point map r ai nf al | with rainfall stations can also be added as another layer.

&

Drag point map r ai nf al | from the Catalog and drop it in the map
window.

In the Display Options dialog box, choose Text and choose Text
Color Cyan; this means you will get the names of the rainfall
stations in cyan next to their location in the map window.

Click the Symbol button and in the Symbol dialog box, select Size
6 and select for the Color Cyan, then click OK.

Click OK in Display Options diaog box.

The points are drawn as a new layer.

&

Place the mouse pointer at arainfall station and press the left mouse
button in the map window. Y ou will get the name of the rainfall
station.

Now you have a map window with four layers: raster map t mb4, segment map
cont our, polygon map | anduse and point map r ai nf al | . The Layer
Management dialog box can be used to add or remove layers. To change the order
of the layers, use drag and drop in the Layer Management diaog box.

&

Press the right mouse button in the map window to see which layers
are displayed in the map window.

Y ou can save the contents of a map window as amap view. A map view saves a set
of layers and the way you displayed them.

&
Open the File menu in the map window and choose Save View As.

Typevi ewfor the map view name, press Tab on the keyboard, and
typevi ewfor thetitle. Then click OK.

Close the map window by double-clicking the Control-menu box.

ILWIS Beginner’s Guide 11
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In the Catalog you will see the map view named vi ewwith itsicon.

&

In the Catalog, press the right mouse button on the map vi ew.

Select Open from the context-sensitive menu.

A map window is opened showing all layers that were previoudy displayed in the
map window.

&

Close the map window.

2.4 Display by attribute

If amap has an attribute table, you might want to see the map displayed by one of
its attributes.

&

Display raster map t nb4 by double-clicking it in the Catal og.

Accept the default display options and click OK.

In this new map window, let’s display the polygon map named ci t ybl with
cityblocks by the attribute | anduse.

&

Drag the polygon map ci t ybl from the Catal og to the map window
of t mb4.

In the Display Options dialog box, select the Attribute check box
and choose LandUse.

Specify Boundary Width 0.
Select Representation and select ci t yl use.
Click OK.

In the map window, the polygons are displayed by their attribute | anduse using
the colors of representation ci t yl use. A representation comprises colors,
patterns, line widths, symbols and symbol sizes used to graphically represent data.

12 ILWIS Beginner’s Guide
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Zoom in on the cityblocks.

Press the left mouse button on one of the cityblocks.

Y ou will see the number of the cityblock (its ID) and the land use information.
Move the mouse pointer through the cityblocks to see their land use information.

&

Close the map window.

Y ou can also display a point map by their attribute values in proportional symbols.
For example, you can display the rainfall values of January for each rainfall station
by a proportional symboal.

&

Open raster map t mb1 and accept the defaults in the Display
Options diaog box.

Drag the point map r ai nf al I from the Catalog into this map
window.

The Display Options - Point Map dialog box is opened.

&

Select the Attribute check box and select column January. This
column contains rainfall values for the month of January.
Values can be displayed proportionally.

Click the Symbol button.
Select the Stretch check box.

The minimum and maximum value of column Januar y are displayed. Now you
can give asymbol size in screen pixels to the minimum and the maximum values.

ILWIS Beginner’s Guide 13
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Type 5 for the minimum and 20 for the maximum size.

Select acolor, then click OK.

Click OK in Display Options diaog box.

The point map with proportional symbols for the rainfall in January is displayed.

2.5 Display tables and graphs

EE

Tables can be displayed in asimilar way as maps. In the Catalog you can find

several tables. Let’stake alook at the attribute table rainfall you used before.

&

Opentabler ai nf al | by double-clicking it in the Catalog.

Switch
view

Domain
items of table
or record
numbers

—

Control-menu box Title bar Menu bar Maximize button
Command line Column button Minimize button
= raintall; [Rainfall data |+] 4
File Edit Columns Optiohs HelpV
| |
> janua¥y | februarv | march | az
Aro Cagua 85 83 76
Cerro HachaMach 170 165 155 =
Colca Pithua 99 a7 4
Laguna Santa Rosa 175 165 160
Laguna Totura 180 170 150
Lagunallarallara 175 170 160
FROMIC 93 a9 81
tagquina 99 a 95 87
M55 4 100 96 87 ¥
« |
\Press F1 fofHelp A /
Record button Status line Field Scroll bar

Figure 2.3 Example of an ILWIS table window.

The table is shown in atable window. The rainfall values per month at each station
are displayed. Tables consist of records and columns, a menu bar and a command
line. By using the scroll bars you can see the other columns and records. There are
two ways to view the data of atable: Table View and Record View.

14

ILWIS Beginner’s Guide



Visualization

Open the Options menu and select Record View to see the contents
of the table record by record.

Use the >, >>, < and << buttons to go to next or previous records.

To go back to Table View, open the Options menu again and choose
Table View. You can aso click the Switch View button.

The data of a column of atable can aso be displayed as a graph.

&

Open the Options menu and select Show Graph.

The Graph dialog box is opened. In this dialog box you can select the columns you
want to use for the graph.

&

Selectrai nfal | val ue for the x-axis and the column Januar y
for the y-axis.

Click OK.

The Edit Graph dialog box is displayed. Y ou can select a graph type and adisplay
color (see User’s Guide).

&

Accept the defaults and click OK.

Theresult isabar graph in red with the amount of rainfall in January on the
vertical axis and the rainfall stations on the horizontal axis.

&

Close all opened windows by opening the File menu of the ILWIS
Main window and select Close All.

ILWIS Beginner’s Guide 15






Chapter 3

Retrieval of information

There are several ways to retrieve information from maps and their attribute tables.

One way to retrieve information from a map is to use the left mouse button in the
map window. In thisway you will get avalue (for example reflectance values of a
satellite image), a class name (for example land use classes) or an ID (for example
the name of arainfall station) of amap. By selecting or clearing the Info check box,
per layer in the Layer Management dialog box, you can customize the
information you will get. How to use the left mouse button is explained in chapter
2.

3.1 Retrieval of information by double-clicking in a map
window

The polygon map | anduse and the point map r ai nf al | arelinked to the
attribute tables| anduse respectively r ai nf al | . You can seethisin the
Properties diaog boxes of the maps.

&

Press the right mouse button on polygon map | anduse to get the
context-sensitive menu.

Select Properties.

The Polygon Map - Properties dialog box is opened. Y ou will see that there is an
attribute table named | anduse linked to the polygon map | anduse.

&

Click Cancel.

The attribute information stored in this attribute table can be accessed by double-
clicking in the map.
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&
Open the map view vi ew created in chapter 2.

Press the right mouse button in the map window; the context-
sensitive menu appears.

Select Double-Click Action.

In this dialog box you can specify what should happen if you double-click with the
left mouse button in the map window. This short cut can be used in three ways. The
default is Edit Attribute. The other options are Edit Representation and Execute
Action (see ILWIS on-line Help).

&
Click OK.

Now you have to make sure that the Info check box of the layers of interest is
activated otherwise you will get no information about them.

&
Press the right mouse button again.
Thistime select Layer Management.

Select thel anduse map and make sure that the Info check box is
selected.

Click OK.

Move through the map and double-click.

Depending on where you double-click, you get information on the land use or the
rainfall values per month. Besides viewing the attributes, you can also edit them in
the Edit Attribute window. The attribute table will be updated immediately.

&

Close the Edit Attribute window by double-clicking its Control-
menu box.
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3.2 Retrieval of information with the Pixel Information window

The Pixel Information window is used to interactively inspect coordinates, class
names, 1Ds or pixel values in one or more maps and attribute values of map-related
tables.

@ (a4

Click the Pixel Info button in the button bar of the Main window or
double-click the Pixel Info item in the Operation-list.

The ILWIS Pixel Information window is opened (Fig. 3.1). First of al this window
shows information about the mouse pointer position in a map window.

&

Move the mouse pointer in the map window to see the XY -
coordinates.

Further you can drag and drop maps from the Catalog into the Pixel Information
window to obtain information stored in the different maps at the same location.

&

Drag and drop polygon map | anduse from the Catalog into the
Pixel Information window.

Also drag and drop segment map cont our , raster map t nb4 and
point map r ai nf al | into the Pixel Information window.

Again, move the mouse pointer in the map window.

Now you get information which is stored in the land use map, the contour map, the
satellite image and the rainfall map. The link between the information is the
location.
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=| ILWIS Pixel Information [~]-
File Edit Options Help

(802490 .911618, 8080273 . 1346551 [ |
Shrubs

Coordinate

93

| |PressF1forHelp

Figure 3.1 Example of the ILWIS Pixel Information window.

The datain the Pixel Information window can be customized.

&

Open the Options menu of the Pixel Information window and select
Customize.

The Customize Pixel Info dialog box is displayed. In this dialog box you can
select which information you want to see in the Pixel Information window.

&

Deselect the maps or columns in which you are not interested by
clicking them. Only the highlighted maps and columns will be shown
in the Pixel Information window.

Click OK.

The customized Pixel Information window is shown.

&

Close all windows.
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Chapter 4

Operations

The left part of the Main window is called the Operation-list. An overview of all
ILWIS operations is given in the list. By using the scroll bar you can go up or down
through the list. By pressing the right mouse button on an operation, you can
choose Run or Help. Run opens the dialog box, Help gives a short explanation of
the operation. Double-clicking an operation opens its dialog box.

This chapter will familiarize you with different ways of accessing operations. Some
operations will be described which can be performed on the ILWIS demonstration
data.

4.1 Basic statistics - creating histograms

i Let's calculate the histogram of t mb1. This histogram shows the frequency
distribution of pixel valuesin satelliteimaget nbl.

&

Scroll through the Operation-list until the Histogram operation is
visible.

Drag raster map t nb1 from the Catalog and drop it on the
Histogram operation in the Operation-list.

The Calculate Histogram dialog box is presented.

&
Click OK.

The histogram of t b1 isdisplayed in atable window. This data can also be
displayed as a graph.
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From the Options menu, select Show Graph.

Selecti mage val ue for the x-axisand npi x for the y-axis.
Click OK.

Accept the defaults in the Edit Graph dialog box and click OK.

The graph is displayed with the default layout.

&

Close the graph window.

Close the table window.

Besides cal culating histograms of images or other raster maps, you can also
calculate histograms of point, segment and polygon maps. As an example, we will
calculate the histogram of the polygon map | anduse.

&

Press the right mouse button on polygon map | anduse in the
Catalog to display the context-sensitive menu.

Choose Statistics and Histogram.

Click OK in the dialog box.

A table window is opened showing the number of polygons and the total perimeter
and area of the polygons, by land use class. This data can also be displayed as a

graph.

&

From the Options menu, select Show Graph.

Select | anduse val ue for the x-axis and ar ea for the y-axis.
Click OK.

Accept the defaults in the Edit Graph dialog box and click OK.

A graph of the area per land use class is displayed.
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Close the graph window and the table window.

4.2 Applying a filter

EH

In ILWISthereis aset of pre-defined filters that you can apply on raster maps. Y ou
can aso create your own filters. Let’s apply an enhancement filter on raster map
t nb1. Thisfilter improves the visibility of linear features, for example roads and

coast-lines.

&
Press the right mouse button on raster map t b1 in the Catalog.

Select Image Processing and Filter from the context-sensitive
menu.

The Filtering dialog box is opened. In this dialog box you can select thefilter to be
applied: you can choose a pre-defined filter or create one yourself.

&
Make sure the Filter Type isLi near . Thisisthe default.
Select edgesenh filter in the Filter Name list box.
Type t nbledg inthe Output Raster Map text box.

Make sure that the Show check box is cleared. No crossis then
visible.

If the Show check box is cleared, the map is not shown immediately; only the map
definition is stored. If the Show check box is selected, the output map will be
calculated and displayed immediately.

&

Accept the defaults and click OK.

In the Catalog your raster map t nh1ledg appeared. The definition of the map can
be viewed in the properties of the map.
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Place the mouse pointer at raster map t nbledg and press the right
mouse button.

Select Properties.

In the Raster Map Properties diaog box, the definition of the map is shown:
MapFi Il ter (tnbl. npr, edgesenh.fil). If youwant to display the map,
it has to be calculated first. Thisis done by clicking the Calculate button in this
dialog box. Y ou can aso close this dialog box and double-click the map t nbledg;
then the map will be automatically calculated and displayed.

&

Click Cancel to close the Raster Map Properties dialog box.

Let’s now compare the original map t nb1 with the output map t nbledg.

&
Double-click raster mapt mb1.
Accept the default display options and click OK.

Double-click raster map t mbledg.

ILWIS starts calculating this map.

&

Accept the display options and click OK.

Place the two map windows next to each others to see both maps totally. The result
of thefiltering is a better visibility of linear featuresin raster map tmbledg. If the
filtered image does not seem sharper then the unfiltered one, zoom in on a
comparable areain both maps.

&

Close both map windows.
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4.3 Create a color composite

i

Spectral information from satellite images can be visualized by combining three

individual bands into one image. One band is displayed in shades of red, onein

shades of green and one in shades of blue. Putting three bands together in one

color composite can give a better visual impression of reality, rather than

displaying one band at atime. There are three types of color composites: natural

color composites, pseudo natural color composites and false color composites.

- Natura color composites are made of the green, blue and red part of the
spectrum. This resultsin an image with realistic colors.

- A pseudo color composite is created with other parts of the spectrum, but the
result has natural looking colors.

- Infase color composites the colors in the image are not the same asin reality
For example healthy vegetation is red and urban areas are blue.

Let’'s make afase color composite of three Landsat Thematic Mapper bands.

&

Scroll through the Operation-list until the ColorComp operation is
visible.

Double-click the ColorComp operation.

The Color Composite dialog box is opened. In this dialog box you can choose

which raster maps you want to use. Y ou can click the Help button if you want more

information about the creation of color composites.

&
Drag the dialog box next to the Catal og.

Drag the t nb4 map from the Catalog and drop it in the Red Band
box.

Then drag t mb3 to the Green Band box and t nb2 to the Blue
Band box.

Type for Output Raster Map namet nb432.

Click the Show check box to immediately calculate and display the
color composite.

Type as aDescription Col or conposite of tnb4, tnb3
and tnb2.

Accept the other defaults and click OK.
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The Display Options - Raster Map dialog box is opened.

&

Accept the default display options and click OK.

The color compositet mb432 is displayed. The colors are false colors. For
example, you can see the vegetation in red and the urban areas in blue.

&

Close the map window.

4.4 Calculating a Normalized Difference Vegetation Index

(NDVI)

i

Map Calculation is a powerful tool in ILWIS for Windows. It is used for the
execution of most spatial analysis functions and modeling operations. MapCalc
enables the user to perform queries and overlays.

The Normalized Difference Vegetation Index (NDVI) is a measurement for the
presence and condition of green vegetation. The function uses two satellite bands;
one containing the red reflectance values and another containing the infra-red
reflectance values. Raster map t mb3 in the ILWIS Demo data set contains the red
reflectance values and t b4 contains the infra-red values. To calculate the NDVI
you have to use these two images.

&
Double-click the MapCalc operation in the Operation-list.

Type the following formulain the Expression text box:
(tmb4 - tnb3) / (tnb4 + tnb3)

Type ndvi t B84 in the Output Raster Map text box.

Select the Show text box and click the Defaults button.

ILWIS determines the value range, precision and domain type.

&
Click OK.

In the Display Options dialog box, select Representation pseudo
instead of the default gr ay and click OK.

26

ILWIS Beginner’s Guide



Operations

Theimage ndvi t n84 is displayed. The values range from -1 to 0.7.

- Vegetated areas will generally yield values close to one because of their
relatively high near-infrared reflectance and low visible reflectance.

- In contrast, water, clouds and snow have larger visible reflectance than near-
infrared reflectance. Thus, these features yield negative index values.

- Rock and bare soil areas have similar reflectance’ sin the two bands and result
in vegetation indices near zero.

Instead of typing the complete expression it is also possible to use the function
NDVI (red band, near infrared band). The NDVI1 is one of the many pre-defined
functionsin MapCalc.

Let’s now use the Map Calculation operation to create a map of areas with ahigh
vegetation index. These are the relatively highly vegetated areas. Let’s assume that
areas with an NDVI larger than 0.1, are highly vegetated. To get a map with these
areas we use an | FF-statement.

&
Double-click the MapCalc operation in the Operation-list.

Type the following formulain the Expression text box:
| FF( (ndvi t n84>0. 1), 1, 0)

Type hi ghveg in the Output Raster Map text box.
Select the Show check box and click the Defaults button.
Click OK.

In the Display Options dialog box select for Representation
pseudo and click OK.

The map hi ghveg isdisplayed. The vegetated areas have value 1 and the other
areas have value 0.

&

Close both map windows.

45 Table Calculation

Table calculation isthe ILWIS application you can use for calculating with
columns of atable. In the next example we will calculate the periodic rainfall for
every three months using the rainfall table.
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4.6 Cross

m

Double-click the attribute table r ai nf al | in the Catalog.

Table calculation expressions can be typed on the command line of the table
window. To get the periodic rainfall values you have to add the values of the three
months and put it in a new column.

&
Type the following expression on the command line;

j anf ebmar =j anuar y+f ebr uar y+mar ch

Press Enter.

The Column Properties dialog box of your new column is opened.

&
Click OK.

In the table window, scroll to the right with the horizontal scroll bar.

The last column is the one you just made. Y ou can see the added values of January,
February and March.

&

Close the table window.

The Demo Data set includes a polygon map geol ogy. This map shows the
geology in the Cochabamba area. Thereis also a map which shows the land usein
the area (I anduse). Let’'stry to see on which geological units what type of land
useisfound. This can be done with the Cross operation. The Cross operation
needs two raster maps as input. At this stage, both the geol ogy and the

| anduse maps are polygon maps, so you first need to rasterize them.
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Press the right mouse button on polygon map geol ogy and choose
Polygon to Raster from the context-sensitive menu.

In the dialog box select GeoReference cochabam

Click OK.

The raster map geol ogy appeared in the Catalog. The same has to be done with
polygon map | anduse.

&

Press the right mouse button on polygon map | anduse and choose
Polygon to Raster from the context-sensitive menu.

In the dialog box select GeoReference cochabam

Click OK.

Although the maps are not calculated yet, only their definition is stored, you can
use them in the cross calculation asif they are already calculated.

&
Double-click Cross in the Operation-list.
Select geol ogy as 1st Map.
Select | anduse as2nd Map.
Typegeol | and in the Output Table text box.
Select the Show check box.
Select the Output Map check box and type geol | and.
Click OK.

ILWIS starts rasterizing both maps and calculating a cross table and a cross map.

After the calculation, the cross table geol | and appears. In this table each
geological unit with its land use is displayed. The number of pixels and areas of
each combination is also stored in the crosstable.
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Maximize the table window to see the number of pixels and the area
of crossed units.

Click the Restore button IEI when finished.

Further, across map geolland is calculated which contains the same combinations
asin the crosstable.

&

To display the cross map, double-click raster map geol | and.

The Display Options dialog box is opened.

&
Select 7, 15, or 31 colorsto display the map.
Click OK.

Raster map geol | and isdisplayed. The two maps geol ogy and | anduse are
overlaid. This creates areas with specific combinations of geology and land use.
Displaying the map in 31 colors alows for a better distinction between the different
units.

With the left mouse button, click in the map window to get information on the
geology and the land use.

Y ou can also open the Pixel Information window and drag the polygon maps
geol ogy, | anduse and geomintoit. Thiswill give you even more
information.

&

Close the map and table window.
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Chapter 5

Annotation

To present mapsit is useful to add annotation like a map title, a scale and a legend.
This chapter will give some examples of basic annotation. The polygon map

geol ogy will be used asabasis. The result can be printed on paper.

=-‘ geology: Polygon map of the Geological units | v| o
File Edit Layers Options Help
D[aJa] [=[o[*]
Geology Map of Cochabamba ki
8090000
H
8000
G000
4000
2000
8080000
B o Glacial deposits
B 1; Lake deposits
[ oa: OId alluvial deposits
8000 [ gu: Quarkites
I ra: Recent alluvial deposits
I =h: Shales
5000 [ si: Siltstanes
M =0 Slope deposits
4000 [ — — ]
I} 000
2000 -1 | | | | 1 1
G000 gooo  #00000 2000 4000 G000 gonn
+
+ u -+
|—><Y:( 80738312, BOBBETH5Y) 17716'00.00"S, BE'OB'33. 29"

Figure 5.1 The polygon map Geology with annotation.
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Double-click polygon map geol ogy.

Accept the defaults display options and click OK.

Y ou will add annotation as layers to the map window. First, you will created some
extra space around the map.

&

Open the Options menu and select Extend Window and Extend by
Percentage.

Click in the text boxes and type the following percentages: 10, 10,
20, 55 and click OK. Use the Tab key to go to the next text box.

The map window is resized.

Now, let’s add atitle.

&

If the Enlarge button is available in the button bar, click this button
to enlarge the map window.

From the Layers menu, select Add Annotation and Text.

Remove the current text in the Display Options-Text dialog box and
type Geol ogy Map of Cochabanba.

Accept other default options and click OK.

The annotation editor is opened: it shows the map Geol ogy and at this moment
thetext Geol ogy Map of Cochabanba appearsin the center of the map
window.

Thetext is selected when it is surrounded by a selection box. The corners of the
selection box are little black handles. The font size can be changed by dragging
these handles. Asyou can seethetitle is already selected.

&
Drag the title to the top of the map window like in Figure 5.1.

Y ou can enlarge the title by dragging one of the size handles of the
title.
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In thisway all text can be added. Y ou can also change the font, size, and the color
of text.

Let’s now add alegend and a north arrow. The legend is created automatically
from the domain of the map and the representation used by the domain.

&

Click the Legend button in the button bar of the Annotation Editor.

T

The Display Options-Legend dialog box is opened. By default all classes are
selected.

&
Accept the defaults and click OK.

Drag the legend to the lower right corner to make it fit better in the
map.
To add a north arrow, click the North Arrow button in the button bar.

The Display Options - North Arrow dialog box is opened.

&
Accept the defaults and click OK.

Drag the north arrow to the upper right corner of the map window.

Resize the north arrow by dragging its size handles.

Finally let's add a scale bar and a grid to the map.

&
Click the Scale bar button in the button bar.
In the dialog box, clear the check box Text 1: ...
Click OK.
Drag the scale bar to the bottom of the map window.
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H#

To display the grid, click the Grid button in the button bar.
Type 2000. 0 asthe Grid Distance.

Clear the Draw Border check box.

Clear the Grid Lines check box.

Select Outside Map.

Click OK.

Reposition the Legend and Scale Bar if necessary.

The result is amap with different layers of annotation. The order of these layers
can be changed in the Layer Management dialog box.

The contents of this map window can be saved as amap view.

&

Open the File menu and select Save View As to save the map
window as amap view.

Type Geol Vi ewfor Map View Name.

Click OK.

To print the map, you need to leave the Annotation editor and return to the map
window.

&

Open the File menu and select Exit Editor to exit the Annotation

Editor and to return to the map window.

Make sure that your printer isinstalled. To check to which printer you are currently
connected or to install a printer, you can select Printer Setup from the File menu.
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Open the File menu and select Print.
Accept the defaults Current window and Fit on Page.
Click OK to print.

The map is printed.

Y ou have now finished the Beginner’s Guide. To further improve your ILWIS
sKills, you can continue with the User's Guide.
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